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Agenda, Day 1

• Overview of Abaqus

• Basic use and concepts

• Geometry modelling 

• Assigning materials and properties

• Meshing and elements

• Loads and Boundary conditions

• Submitting analyses

• Viewing results

• Static analysis Workshops

• Vibration mode analysis Workshop

http://www.rand.fi/
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What is Abaqus?

• Suite of finite element analysis modules

• Graphical user interface Abaqus/CAE 

• Solvers Abaqus/Standard & Abaqus/Explicit

http://www.rand.fi/


© 2023 Rand Simulation Oy
Simulation

Let Knowledge be your guide

w
w

w
.r

a
n

d
.f

i
| 
R

a
n

d
 S

im
u

la
ti

o
n

 O
y

Overview of Abaqus/CAE

• Graphical user interface to create, edit, monitor, 

diagnose, and visualize Abaqus analyses

• Supports familiar interactive computer-aided 

engineering concepts as

– feature-based, parametric modelling

– interactive and scripted operation

– GUI customization

• Provides the most complete interface with the 

Abaqus solver programs available.

• Uses neutral database files that are machine 

independent (Windows   Linux)

• Powerful extensibility & customization

– Python scripting language

– Automate repetitive tasks with macros

– Build customized GUIs

http://www.rand.fi/
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Overview of Abaqus/CAE

• Create the

part geometry 

(and regions 

for

sections, if 

necessary)

• Position parts for

initial configuration.

• Split 

assembly into

meshable

regions and 

mesh

• Define analysis steps  

and output requests

• Define materials

• Define additional     

part regions

• Define and 

assign sections 

to parts or 

regions

• Define contact 

and

other interactions

on regions or  

named sets, and 

assign them to 

steps in the 

analysis history

• Apply loads, 

BCs, and ICs to 

regions or 

named sets; and 

assign them to 

steps in the 

analysis history

• Submit, 

manage,

and monitor 

analysis jobs

• Examine 

results

Part Assembly

Step Load

Mesh Visualization

Property

Interaction

Job

• Functionality is presented in modules.

• Each module contains a logical subset 

of the overall functionality.

• Once you understand the presentation 

of one module, you can easily 

understand the presentation of the other 

modules.

http://www.rand.fi/
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Overview of Abaqus/CAE

• Model Tree and the Results Tree

– The Model Tree provides you with a graphical overview of 

your model and the objects that it contains.

– The Results Tree is used to display analysis results from 

output databases as well as session-specific data such as 

X–Y plots. 

– Both trees provide shortcuts to much of the functionality of 

the main menu bar, the module toolboxes, and the various 

managers.

http://www.rand.fi/
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Starting Abaqus/CAE

1. Command line

– abaqus cae

– Opens Abaqus/CAE in current directory

2. Windows Start menu

– Opens Abaqus/CAE in startup 

directory set during installation

3. Double-click .cae or .odb file in Windows folder

– Opens Abaqus/CAE in current directory

Suggested workflow when starting new project

• Start Abaqus/CAE from Start menu

• Create and/or select a new directory for the project

• Now all analysis and results files are created in this 

directory, and things stay organized

– Otherwise, the default work directory given 

during installation is used for all files Select directory (Do not 

open/go into directory)

Option 1 Option 2

http://www.rand.fi/
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Basic use of Abaqus/CAE

• View manipulation

– Toolbar  to control view (pan, zoom, rotate, etc.).

– Alternatively, can use a combination of keyboard and mouse 

actions:

– Rotate: [Ctrl]+[Alt]+MB1.

– Pan:  [Ctrl]+[Alt]+MB2.

– Zoom:  [Ctrl]+[Alt]+MB3.

– You can reconfigure these combinations to mimic the view 

manipulation interfaces used by other common CAD applications

• Selecting entities from main window

– Add to selection: [Shift] + MB1

– Remove from selection: [Ctrl] + MB1

Example: Selecting faces 

from model in Main window

http://www.rand.fi/
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Model 

1

Model 

2

Model 

3

Model database (.cae)

Overview of Abaqus/CAE

• What is a model database file (extension .cae)?

– Contains all the information for any number of models.

– Typically contains one model or several related models.

– Only one model database can be opened in Abaqus/CAE at a time.

• What is a model?

– Contains all the necessary information for an analysis.

– Contains any number of parts and their associated properties.

– Is independent of other models in the model database.

– Objects such as parts and materials can be copied between different models in the same database.

– Contains a single assembly of part instances, including the associated contact interactions, loads and 

boundary conditions, mesh, and analysis history.

http://www.rand.fi/
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Basic use of Abaqus/CAE

• Models can be imported into one database from another

• Model data from the imported database is copied into the 

current database.

– E.g., parts, sections, assemblies, materials, loads, BCs, etc.

• Analysis job definitions and custom data are not copied

User A User B Master 
Model

=+

http://www.rand.fi/


© 2023 Rand Simulation Oy
Simulation

Let Knowledge be your guide

w
w

w
.r

a
n

d
.f

i
| 
R

a
n

d
 S

im
u

la
ti

o
n

 O
y

Overview of Abaqus/Standard and Abaqus/Explicit

• Abaqus/Standard analysis types

– Static stress/displacement analysis:

– Linear and nonlinear analysis

– Rate-dependent or rate-independent response

– Eigenvalue buckling load prediction

– Linear dynamics:

– Natural frequency extraction

– Modal superposition

– Harmonic loading

– Response spectrum analysis

– Random loading

– Linear/Nonlinear dynamics:

– Transient dynamics, Implicit time integration

Articulation of an automotive boot seal

Harmonic excitation of a tire

http://www.rand.fi/


© 2023 Rand Simulation Oy
Simulation

Let Knowledge be your guide

w
w

w
.r

a
n

d
.f

i
| 
R

a
n

d
 S

im
u

la
ti

o
n

 O
y

Overview of Abaqus/Standard and Abaqus/Explicit

• Other analysis types available in Abaqus/Standard:

– Heat transfer 

– Acoustics

– Mass diffusion 

– Steady-state transport

• Multiphysics with Abaqus/Standard:

– Thermal-mechanical analysis

– Structural-acoustic analysis

– Thermal-electrical (Joule heating) 

analysis

– Linear piezoelectric analysis

traction

braking

free rolling

Steady-state transport: rolling of a tire on a drum

Thermal stresses in an exhaust manifold

http://www.rand.fi/
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Overview of Abaqus/Standard and Abaqus/Explicit

• Abaqus/Explicit

– Simulates high speed dynamic events such as drop tests.

– Explicit algorithm for updating the mechanical response.

– Also, a powerful tool for highly nonlinear quasi-static analyses

– Material plasticity & damage, multiple compilated contacts, large 

deformations,...

– Annealing is available for multistep forming simulations

Drop test of a cell phoneRolling of a symmetric I-sectionCrimping of terminal

http://www.rand.fi/
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Overview of Abaqus/Standard and Abaqus/Explicit

• Multiphysics with Abaqus/Explicit

– Thermal-mechanical analysis

– Fully coupled: Explicit algorithms for both the mechanical and 

thermal responses

– Can include adiabatic heating effects

– Structural-acoustic analysis

– Fluid-structure interaction

Two-stage forging, using ALE—contours of temperature

adiabatic

fully coupled temperature-displacement

http://www.rand.fi/


© 2023 Rand Simulation Oy
Simulation

Let Knowledge be your guide

w
w

w
.r

a
n

d
.f

i
| 
R

a
n

d
 S

im
u

la
ti

o
n

 O
y

Overview of Abaqus/Standard and Abaqus/Explicit

• Special features of Abaqus/Explicit: ALE

– Adaptive meshing using ALE techniques allows the robust solution 

of highly nonlinear problems.

– Mesh adaptivity is based on solution variables as well as minimum 

element distortion. 

– Elements concentrate in areas where they are needed. 

– Adaptation is based on boundary curvature.

• Special features of Abaqus/Explicit: Coupled Eulerian-Lagrangian (CEL)

– Define a domain in which material can flow for an Eulerian analysis

– Flow problems

– Structural problems with extreme deformation 

Bulk metal forming High speed impact

Eulerian mesh

rod material

High speed impact of copper rod

Fluid drop

http://www.rand.fi/
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Abaqus Conventions

• Abaqus uses no inherent set of units.

– User inputs numbers and Abaqus works with these

• It is the user’s responsibility to use consistent units. Examples:

– SI: kg, m, s  Force: N, Stress: Pa

– SI (mm): ton (103 kg), mm, s  Force: N, Stress: MPa

• Other unit systems and units shown in table below

Common systems of consistent units

Most common, and 

generally recommended

Example: Properties of structural steel in SI (mm):

Density: 7.85e-9  [ton/mm3]

Young’s modulus: 206 000 [MPa]

http://www.rand.fi/
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Abaqus Conventions

• For boundary conditions and point loads, the default coordinate system is the rectangular Cartesian system.

– Alternative local rectangular, cylindrical, and spherical systems can be defined. 

– These local directions do not rotate with the material in large-displacement analyses.

local rectangular 

coordinate system 

with YSYMM 

boundary conditions

Boundary conditions on a skew edge

http://www.rand.fi/
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Abaqus Conventions

• For material directions (i.e., directions associated with an element’s material 

or integration points) the default coordinate system depends on the element 

type: 

– Solid elements use global rectangular Cartesian system.

– Shell and membrane elements use a projection of the global Cartesian 

system onto the surface.

Default material directions for shell and 

membrane elements

Default material directions for solid elements

Global coordinate 

system

http://www.rand.fi/
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Abaqus Conventions

– Alternative rectangular, cylindrical, and spherical coordinate systems may be defined.

– Affects input: anisotropic material directions.

– Affects output: stress/strain output directions.

– Local material directions rotate with the material in large-displacement analyses.

2

1

Assign 

material 

orientations

Pre processing

Plot 

material 

orientations

Post processing

http://www.rand.fi/
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Abaqus Conventions

• Degrees of freedom

– Primary solution variables at the nodes.

– Available nodal degrees of freedom depend on the element type.

– Each degree of freedom is labeled with a number: 1=x-displacement, 2=y-displacement, 11=temperature, 

etc.

http://www.rand.fi/


© 2023 Rand Simulation Oy
Simulation

Let Knowledge be your guide

w
w

w
.r

a
n

d
.f

i
| 
R

a
n

d
 S

im
u

la
ti

o
n

 O
y

Demonstration of Abaqus/CAE basic functionality

http://www.rand.fi/
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Static analysis of I-profile cantilever beam

• IPE80

– h = 80

– b = 46

– t = 5.2

– s = 3.8

• E = 206 GPa,   = 0.3

• F = 1000 N

• L = 2000 mm

• Use beam elements

This end is 

fixed

F

http://www.rand.fi/
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Step 1: Create a part

For beam elements

• Modelled geometry: Line/Wire

• Data given by section properties:

– Material

– Profile shape

– Profile Orientation

Part module

Create 

part

Give approximate size of 

drawing canvas

Sketch line

Familiarize yourself with the 

sketching tools by testing

Sketcher options

Modify size of 

drawing canvas

An image can be imported, scaled, and set 

on the background of the canvas. This can 

help in modelling complex shapes: take a 

photo, set is as background image, and 

draw lines according to the photo

http://www.rand.fi/
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Step 2: Create material, profile, and beam section

Elastic material, Units SI (mm)

Profile

Material

1:

2:

3:

Section

Select the previously defined 

profile and material

Note: If Material or Profile 

was not created earlier, short 

cuts are available here

Beam axis 1 direction will 

be used to define beam 

orientation on next slide

Property module

http://www.rand.fi/
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Step 3: Assign beam orientation

Assign section

1.1: Pick line representing beams geometry

1.2: Optional, Create a named Set of selected region. 

Helpful, if model has several regions with different 

properties

1:

2: Assign orientation

After section and orientation 

assignments are done, the beam  

profile can be visualized:

Main menu: View > Part Display

Options

Beam profile visualization

1. Select region (the line representing the beam)

2. Abaqus/CAE shown arrows along beam tangent. Give 

approximate direction for beam cross section axis 1 (see 

profile definition on previous slide for axes 1 and 2 directions)

http://www.rand.fi/
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Step 4: Create the Assembly

• An “Instance” of a part is created in the assembly

• Multiple instances of the same part can be created

– Part instances can be moved and rotated as needed

– If changes are made to the part; modified dimensions, materials, section properties and 

assignments,... all instances of the part in the assembly are updated

• IMPORTANT: The assembly is what is used in the analysis

– Parts that are not instanced are not considered in the analysis

Assembly module

Create 

Instance

Select 

beam part

Tip 1: After creating instances, check the 

number of instances under Assembly > 

Instances in the model tree. Make sure 

you have not created multiple instances of 

the same part by accident 

Tip 2: Assembly level has it’s own display 

settings. Beam profile rendering in the 

Assembly level modules can be switched 

on from Main menu > View > Assembly 

Display Options

http://www.rand.fi/
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Step 5: Create analysis step

Analysis step defines what is calculated

Create 

Step

Step module

Accept all defaults

Select SF

Modify the default output request to add output of 

beam section forces SF. This is needed to visualize 

the stress on the beam cross section.

http://www.rand.fi/
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Step 6: Define loads and boundary conditions

The analysis step defines what is calculated

Create 

Load

Load moduleLoad is applied in Step-1

Create 

Boundary 

conditions

Select the vertex at the 

opposite end of the beam 

compared to the where the 

load is applied.

All displacements and 

rotations are set to zero
Fixed Boundary conditions are applied at this end

Select vertex at the end of the 

beam for the force load

http://www.rand.fi/
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Step 7: Mesh the part

• The geometry is divided into finite elements for the calculation

Tip 1: When you see this error, switch to the Part 

level in the mesh module and try again.

Assign global seed size. This is the approximate 

distance between nodes of the mesh.

The approximate node locations along 

edges are shown in the viewport

1:

2:

Mesh the model

Tip 2: Use Query Information to get the details of the

mesh.

Info is printed in the message are under the main 

window.

Remember: Student Edition has the limit of 1000 nodes

Mesh module

http://www.rand.fi/
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Step 8: Create a Job and submit the analysis

Give a name to the job. All

analysis and output files

will have this name.

If you have multiple models in 
your .cae database, select the 

one you want to analyse.

Job module

Accept all defaults

Once the Job has been created, it can be submitted for analysis.

Option 1: Right click the Job in the 

Model tree and select Submit

Option 2: Open the Job manager and 

select Submit

Create 

Job

http://www.rand.fi/
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Step 9: Visualize the results
Check that the job has completed from the Model tree or Job manager

Right click

Visualization module

http://www.rand.fi/
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Tips for result visualization
Rendering beam profiles and shell thickness

Selecting variable to show in contour plot

Note: Output variable SF must be included 

in outputs to get BEAM_STRESS

Common output variables

U/UR: Displacement (translations/rotations)

S: Stress

E: Linear strain (for linear problems)

LE: Logarithmic strain

RF/RM Reaction forces (force/moment)

CF/CM: Concentrated loads (force/moment)

SF/SM: Beam section forces (force/moment)

Vector or Tensor component or 

scalar (magnitude, equivalent 

stress,.. etc.) is selected here.

http://www.rand.fi/
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Tips for result visualization

• For solid elements visualization is trivial: Result value at each point is unambiguous

• For shell elements the result value can be from various locations in the thickness of the shell

• For beam elements the result value can be from various locations of the profile cross section

Example of beam element output. Location of 

stress visualized by colours is given in the 

legend. Note that the Mises stress in each cross

section is constant because the Lower flange 

left corner value is plotted for the whole 

visualized cross section.

Exception: BEAM_STRESS output plots the

stress correctly across the beam cross section. 

However, this output variable is valid only for 

linear elastic material. Do not use with plasticity.

Location in the shell thickness direction or the position in beam 

cross section used for output is selected from Main menu > 

Result > Section Points

http://www.rand.fi/
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Static analysis of U-profile cantilever beam

U-profile 60x140x6

L = 2000 mm

E = 206 GPa,   = 0.3

F = 1000 N

This end is 

fixed

F

meshed using linear 

shell elements S4R

http://www.rand.fi/
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Step 1: Create a shell part

• This time shell elements are used to model the beam

– The cross section is modelled as geometry

– Material and thickness are given as section properties

Create part with 

base feature Shell, 

Extrusion

Cross section for 

extruded shell. 

Note: Dimensions 

correspond to the 

middle surface of the 

profile cross section. 

Outer dimensions: 

60x140x6

After sketching, exit the sketcher and 

give 2000 for the extrusion depth.

http://www.rand.fi/


© 2023 Rand Simulation Oy
Simulation

Let Knowledge be your guide

w
w

w
.r

a
n

d
.f

i
| 
R

a
n

d
 S

im
u

la
ti

o
n

 O
y

Step 2: Create and assign section

Create a shell section

Shell thickness

Material (Created earlier)

Sketch of cross section was done using the middle surface dimensions, so 

Middle surface is selected. Optionally the thickness can be offset with 

reference to the modelled geometrical surface

Tip: After Section assignment the shell thickness can be visualized:

Main menu > Part Display Options > Render Shell Thickness

http://www.rand.fi/


© 2023 Rand Simulation Oy
Simulation

Let Knowledge be your guide

w
w

w
.r

a
n

d
.f

i
| 
R

a
n

d
 S

im
u

la
ti

o
n

 O
y

Next steps

• Similarly as in the first example:

– Create the assembly

– Create an analysis step (Static, General)

– Apply loads and boundary conditions

– Mesh the part

– Create an analysis job

– Submit the analysis

Fixed boundary conditions at the 

other end of the beam
Concentrated force at one end of

the beam

http://www.rand.fi/
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General and Linear perturbation steps

• Abaqus has General steps and Linear perturbation steps

• Linear perturbation = small displacements around a base state

– Linear analysis 

– Small displacements

– Only elastic material response considered

– Contact status remains the same as in base state

• Base state:

– Initial state of model, if linear perturbation is the first step of the analysis 

– State at the end of the preceding General step where NLGEOM is on

• Linear perturbation steps do not effect the time history of a sequence of General steps

– Duration of linear perturbation step is 1e-36

http://www.rand.fi/
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General and Linear perturbation steps

• Example: Vibration modes of tensioned string

• Sequence of steps

Density: 7.85E-9  Ton/mm**3

E: 200 000 MPa

Length: 500 mm

Diameter: 0.1 mm

Tension: 1 N & 2 N

Element type: B23

Apply tension 1 N

Apply tension 2 N

Calculate eigenmodes

Calculate eigenmodes

Applied force

Ux & Uy fixed

Analytical: 180.11

Analytical: 127.36

1st vibration mode with 1 N tension

1st vibration mode with 2 N tension

Uy fixed

http://www.rand.fi/


© 2023 Rand Simulation Oy
Simulation

Let Knowledge be your guide

w
w

w
.r

a
n

d
.f

i
| 
R

a
n

d
 S

im
u

la
ti

o
n

 O
y

Agenda day 2

• Geometric nonlinearity

• Material nonlinearity

• Constraints and contacts

• Nonlinear static analysis Workshops

• Eigenmode buckling analysis Workshop

• Dynamic analysis Workshop

http://www.rand.fi/
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Linear and non-linear problems

• Properties of the linear problem

– Load scaling

– Calculated result U (can be displacement, stress,...) due to load F

– If load F is increased 4x, the result U will be also 4x bigger

– Load superposition

– Load F1 causes result U1

– Load F2 causes result U2

– If loads F1 and F2 act at the same time, the result U = U1 + U2

– The final state is independent of the loading order.

– If the load F1 is applied first and then the load F2, the result U will be the same as in the 

case when first load F2 and then load F1 would be applied.

• If the problem in non-linear the above-mentioned statements do not hold true.
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Linear and non-linear problems

• The most common causes of non-linearity in structural analysis:

– Large displacements; geometric non-linearity

– Non-linear material behavior; material non-linearity

– Plasticity

– Hyperelasticity

– Material damage model

– Contact

– Opening and closing of contact

– Change in the friction contact state: slip/stick

– Non-linear connectors

– Non-linear springs

– Locking/opening/damage connectors

http://www.rand.fi/
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Geometric nonlinearity

Some examples of geometric non-linearity:

• Effect on load carrying mechanism

– Shell begins to carry load in the membrane mode

– Directions of support forces change (rope)

• Effect on loading

– Change of load orientation or length of moment arm

– crank mechanism

– Surface area of pressure load changes

– inflating a balloon

http://www.rand.fi/


© 2023 Rand Simulation Oy
Simulation

Let Knowledge be your guide

w
w

w
.r

a
n

d
.f

i
| 
R

a
n

d
 S

im
u

la
ti

o
n

 O
y

Geometric nonlinearity

When must geometric nonlinearity be considered?

• Good rule of thumb: If the deformation is not visible by naked eye, there is likely no need to 

consider geometric nonlinearity.

• Some cases cannot be calculated without considering the geometric nonlinearity.

– For example, a rope loaded in a transverse direction.

http://www.rand.fi/
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Geometric nonlinearity

• Example: rope, which has no bending stiffness 

– Carries only tension force in the longitudinal direction

– Rope force N

F

F

N NF
NN

Free body diagram

In the initial state, when the rope is straight, 

there is no solution for the equilibrium problem.

The equilibrium is found only, when the rope force N gets the 

vertical component at the support points due to deformation.
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Geometric nonlinearity: Example

• Steel plate loaded on one side by evenly distributed pressure

– dimensions: 600 mm x 400 mm

– thickness: 1 mm

– material: E = 200 GPa

x

yz

Displacement in z 

direction is set to 

zero along all edges

Displacement at the center point is 

analysed

Displacements in xy

plane constrained at 

3 corners only to fix 

rigid body motions

http://www.rand.fi/
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Geometric nonlinearity: Example

Loading 100 Pa 

Non-linear Linear

Displacement [mm]

http://www.rand.fi/
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Geometric nonlinearity: Example

Non-linear Linear

Stress [MPa]Loading 100 Pa 
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Geometric nonlinearity: Example

Loading 25850 Pa = 0.2585 bar

Non-linear Linear

Stress[MPa]
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Geometric nonlinearity: Example

Displacement of the center point

Geometrical non-linearity begins to be 

apparent at pressure of ca. 2 kPa

The result of pressure load 10 kPa (0.1 bar) are 

already completely different: 11 mm vs. 110 mm

http://www.rand.fi/
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Geometric nonlinearity: Example

• Question: What causes this big difference?

• Answer: As the displacement increases, the plate begins 

to carry in the membrane mode.

x

yz

SF1 = membrane force in plate [N/mm] in direction x

Colors are only decimal noise, magnitudes 

1.e-13 to 1.e-15.

In the linear model, the membrane force is not 

generated. It is generated only from the 

geometrical non-linearity. 
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Geometric nonlinearity

Computing time

• In a linear problem the system of equations is solved only once

• Geometrically non-linear analysis requires iteration

– The system of equations is solved in each iteration

– Thus, each iteration cycle corresponds to roughly one linear analysis

– Geometrically non-linear analysis computing time  2 - 100 times the linear analysis

– If there are other non-linearities, e.g., contact, yielding material, the counting time will 

increase even more

– Iterations for material model equations and contact forces

http://www.rand.fi/
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Displacement of the slab center point and required iteration rounds

Geometric nonlinearity
• Example of iteration history of the plate analysis involving only 

geometric nonlinearity

SUMMARY OF JOB INFORMATION: STEP  INC ATT SEVERE EQUIL TOTAL  TOTAL STEP       

INC OF       DOF    IF

DISCON ITERS ITERS TIME/    TIME/LPF    TIME/LPF    MONITOR RIKS

ITERS               FREQ

1     1   1     0     4     4  0.00100    0.00100    0.001000  

1     2   1     0     3     3  0.00200    0.00200    0.001000  

1     3   1     0     3     3  0.00350    0.00350    0.001500  

1     4   1     0     3     3  0.00575    0.00575    0.002250  

1     5   1     0     3     3  0.00913    0.00913    0.003375  

1     6   1     0     3     3  0.0142     0.0142     0.005063  

1     7   1     0     3     3  0.0218     0.0218     0.007594  

1     8   1     0     3     3  0.0332     0.0332     0.01139   

1     9   1     0     3     3  0.0503     0.0503     0.01709   

1    10   1     0     3     3  0.0759     0.0759     0.02563   

1    11   1     0     3     3  0.114      0.114      0.03844   

1    12   1     0     3     3  0.172      0.172      0.05767   

1    13   1     0     4     4  0.258      0.258      0.08650   

1    14   1     0     4     4  0.388      0.388      0.1297    

1    15   1     0     4     4  0.583      0.583      0.1946    

1    16   1     0     4     4  0.875      0.875      0.2919    

1    17   1     0     3     3  1.00       1.00       0.1252    

THE ANALYSIS HAS COMPLETED SUCCESSFULLY

Number of iterations

Time instant of the analysis

16

28

41

49

56

http://www.rand.fi/
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Material nonlinearity

• Plastic material (more details later)

– When the yield limit is exceeded, permanent deformations arise

– Scope of the linear analysis: yield limit is not exceeded 

• Large strains

– Elastic strains are so large that the linear material model is not realistic

– Elastomers, plastic materials, rubber

– Scope of the linear analysis: maximum strain ca. 5%

http://www.rand.fi/
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Material nonlinearity

• Damage models

– The yield limit and the elastic stiffness change

– E.g., concrete, figures below

– Damage cannot be modeled by linear models Reinforced concrete structure

- Reinforced elastic-plastic model

- Elastic-plastic concrete damage model

http://www.rand.fi/
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Plasticity

• When the load is high enough, permanent deformation begins to occur in the material

– The deformation will not disappear even if the load is removed

• For metals von Mises plasticity (J2-theory) is most commonly used

• Use in Abaqus:

– The program is provided with a stress-strain relation, obtained from a tensile test

– Abaqus calculates the stresses, and based on them, the equivalent von Mises stresses

– If the yield limit is exceeded, the program iterates until the stress is obtained at the yield limit

– Iteration: Searching for a deformation state at which the stress is at most at the yield 

limit and the structure in balance

– Iterations always increase the computational cost

– From the calculation effort point of view, each iteration cycle corresponds to 

approximately one static linear analysis
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Plasticity, hardening

• Hardening: Yield limit grows with plastic deformation

Strain

Stress

Yield limit m0

Yield limit m1

Plastic strain p0

Fracture

Slope of the linear part = 

modulus of elasticity

http://www.rand.fi/
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Plasticity, hardening

Strain

Stress

mi

-mi

Strain

mi

-(0 - mi)

mi
m0

2mi

Isotropic hardening: 

Tensile yield increases 

also on the compression 

side yield strength

Kinematic hardening: 

If the yield limit 

increases on the 

tension side, it 

decreases on the 

compression side.

Bauschinger efect2m0

http://www.rand.fi/
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Plastic material, strain rate dependence

• The plastic behavior of structural steel depends on the loading rate *)

– The yield and ultimate strength increase as the load speed 

increases

• Can be added to the model, rate dependent plasticity

– The material parameters are given as a function of the strain

rate

*) Ref.: P.Soroushian, K-B.Choi, Steel 

mechanical properties at different 

strain rates, J. Struct. Eng. 1987, 

113(4):663-672.

Stress

Strain

Low strain rate:

Yield 355 MPa
Plastic region

High strain rate:

Yield 451 MPa

Ultimate strength 571 MPa

Ultimate strength 510 MPa

http://www.rand.fi/
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Plasticity, usage recommendations

• If the load is monotonous (steadily increasing) or the load direction does not change, then

– At simplest, give only one yield limit m0

– At the simplest, give only one ideal elastic-plastic material, no hardening

– For numerical reasons, it is generally advisable to use a small hardening

– Use isotropic hardening, yield limit is given as a function of plastic strain

– These are easy to calibrate and to implement into the model, computationally light

• When the load is changing (tension-compression) use:

– Either kinematic

– Or combined isotropic+kinematic hardening

– These are more difficult to calibrate, computationally heavy

Strain

Stress

Elastic

Ideal elastic-plastic

Elastic-plastic with hardening

Stress-strain curves

http://www.rand.fi/
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Plasticity, example

• Cantilever beam, material S355 (yield limit 355 MPa, small hardening)

This end is rigidly fixed
Distributed pressure load on the 

top surface

http://www.rand.fi/
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Plasticity, example

• Calculated with the second-order solid tetra elements (Abaqus C3D10)

• Von Mises [MPa] in the figure.

• Question: Is there something strange?

Answer: The maximum stress somewhere in the model is 704 MPa. 

The material yield limit is 355 MPa.

http://www.rand.fi/
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Plasticity, example

• Question: Why is the stress higher than the yield limit?

• Answer: The yielding due to bending begins on the surface, however, the material model is 

evaluated at the integration points inside the element. The stress at the integration points has 

maximum value of 355 MPa, but when extrapolated, the stress on the surface becomes too large.

The maximum stress somewhere in the model is 704 MPa. 

The material yield limit is 355 MPa.

http://www.rand.fi/
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Plasticity, example

• When calculated with linear shell elements S4R and solid tetrahedrons C3D10HS (integration 

points on the surface)

The biggest stress is now on the 

yield limit for both models.

S4R                                                                                             C3D10HS

http://www.rand.fi/
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Plasticity, example

• The largest plastic equivalent strain: shell 0.53%, solid 0.59%

S4R                                                                                             C3D10HS

http://www.rand.fi/
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Plasticity, example

• However, even with ordinary solid tetras, the tension result is not as bad as it first appeared

C3D10                                                                                             C3D10HS

The stress upper limit is set to 356 MPa. 

Higher stress shown in black.

http://www.rand.fi/
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Plasticity, example

• The displacement result is practically the same in all models.

C3D10                                                                                             C3D10HS

Note: deformation scaled by factor 10. 
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Plasticity, example

Number of DOF of the model

– Shell S4R: 630 (computationally by far the lightest)

– Solid model C3D10: 7446

– Solid model C3D10HS: 7840 (computationally the heaviest)

Question 1: Why does the shell element give the stress result correctly?

Answer 1: The shell element has an integration points on the surface where the greatest bending stress is obtained. The 

shell elements are very good in describing yielding in bending. By default, Abaqus uses 5 integration points in the thickness

direction of the shell.

Question 2: What should be considered, when using traditional solid elements in analyses involving plasticity?

Answer 2: The mesh must be file enough close to the surface to get integration points close to the surface.

If being cautious, the higher stresses than yield limit can be accepted. The color scale should be changed in the pictures.

Question 3: Why do C3D10HS elements have more DOF than the C3D10, even though both models have the same 

number of elements?

Answer 3: The C3D10HS elements incorporate the internal pressure DOF in the calculation. H = Hybrid element

http://www.rand.fi/
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Workshop; Contacting beams

• Use a shell element model

• Dimensions [mm], L x W x t = 400 x 20 x 1

• E = 200 000 MPa,  = 0.3

• Pressure load on top beam: 0.001 MPa

• Interaction properties for contact

40 mm

40 mm

p = 0.001 MPa 

Sketch of planar shell

Tangential behaviour: 

Frictionless

Interaction for contact: General 

contact, All with Self

http://www.rand.fi/
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Steps

• Create a shell part. Two options for base feature

– Planar shell

– Extruded shell

• Create material and shell section

• Assign shell section

• Mesh part

• Create two instances of the same part in the Assembly

– Both beams are identical, no need to define two identical parts. Instead, two  instances of the same 

part are created in the assembly

• Position the two beams using the Translate Instance tool

http://www.rand.fi/
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• Create an analysis step: Static, General 

• In the Interaction module create a Contact property and Contact interaction as shown 

on the previous slide

– By default parts in the assembly do not interact with each other in any way

– The analyst must define contacts or constraints between the parts

Steps, continued

Switch on Nonlinear geometry, as 

large displacements are expected

Reduce the initial time 

increment to 0.1

In static analysis time does not have a physical meaning. 

It is used to increment the loads and describe the order in 

which thing happen.

The time period of the step is set to 1. The initial

increment is set to 0.1. This means, that Abaqus will try

to apply 10% of the load and find an equilibrium state for 

the structure. After this Abaqus increases the load and 

again finds an equilibrium state. This process is repeated 

until the full load has been applied.

The incrementation of the load is automatically adjusted 

by Abaqus based on the convergence history.

http://www.rand.fi/
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Steps, continued

• Create an analysis Job and submit the analysis

• Check the results

The iteration process and 

convergence history can be 

monitored

Step time=1  Step completed

Time/Load 

increment taken by 

Abaqus

Number of iterations 

needed to find 

equilibrium for increment

U = Unsuccessful. 

Increment aborted and 

attempted again using 

smaller increment

Displacements of contacting beams

http://www.rand.fi/
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• Plasticity data are entered using true stress and 

logarithmic plastic strain.

• If necessary, convert nominal strain to log strain using 

the equation (1) given on the right

• When a material has incompressible behavior (as is the 

case for rubber and most metals when they deform 

plastically), the relationship between “true” stress and 

nominal stress is given by equation (2) on the right

• Use the following relation to determine the log plastic 

strain:

Material plasticity

1

.pl el E    = − = −

nom .ln(1 ) = +

Log strain Nominal strain

.(1 )nom nom  = +

True stress Nominal stress Nominal strain

plastic strain at initial yield is zero

Slope = E

 pl 

(1)

(2)
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Material plasticity

• Adding plasticity to Contacting beams example

Plasticity added into material definition

RELEASE step added

Pressure load deactivated in 

RELEASE step

Due to plasticity, some deformation 

remains after the load is removed.

http://www.rand.fi/
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Linear buckling analysis

• Possible starting points for buckling analysis

– As first analysis step: Geometry as modelled, Load: Only buckling load

– As first analysis step with *INITIAL IMPERFECTION: Geometry modified by imperfection, Load: Only 

buckling load

– After a general step with NLGEOM=ON: Deformed geometry from previous step, Load: Loads from previous 

step as “dead loads”, Buckling load with respect to loads applied in Buckling step

• Creating a Buckling analysis step

Suggested to start with Lanczos

eigensolver with default settings

http://www.rand.fi/
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Linear buckling analysis

• Example: Buckling analysis as the first step:

Result

Buckling load = Eigenvalue∙Applied load

http://www.rand.fi/
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Linear buckling analysis

• Example with “dead load”

Apply dead loads, Calculate static equilibrium

Apply active loads, Calculate buckling

Dead load in static step

Active load in Buckling step

Deads load 0 0.004

Active load ∙ Eigenvalue 1.029E-02 6.288E-03

Total 1.0288E-02 1.0288E-02

Buckling load = Dead load + Eigenvalue∙Active load

Result

http://www.rand.fi/
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Linear buckling analysis

General notes

• Eigenvalue is with respect to all active loads acting simultaneously

– Most load types can be used

– Nonzero boundary conditions can be applied

• The Lanczos eigensolver cannot be used with

– a model containing hybrid elements or connector elements

– distributing coupling constraints

– contact interactions

– a model that has been preloaded over the buckling load

– a model that has rigid body modes

http://www.rand.fi/
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Buckling of a cylindrical shell

• Material. E = 70 000 MPa,  = 0.3

• Height = 520 mm, Radius = 300 mm

• Distance between reinforcement rings = 125 mm

• Thicknesses: Cylinder: 5 mm, Rings: 10 mm

Unit pressure load on 

outer surface

Translations fixed 

along bottom edge

http://www.rand.fi/
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Dynamic analysis of I-profile cantilever beam

• IPE80

– h = 80

– b = 46

– t = 5.2

– s = 3.8

• E = 206 GPa,   = 0.3,  = 7.85e-9 Ton/mm3

• p = 0.05 MPa

• L = 2000 mm

• Use shell elements

Task 1: Static analysis

• Calculate static deformation for reference

Task 2: Vibration modes

• Find frequency of vibration mode that is likely to be excited 

by dynamic loading

Task 3: Transient dynamic analysis

• Calculate transient dynamic response (see next slide)

All translations fixed

x and y 

translations 

fixed

Assumption of static analysis: Load is applied 

slowly, vibrations are not excited.

How much higher is the maximum displacement, if 

the same pressure load is suddenly applied on the 

beam?

http://www.rand.fi/
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Dynamic analysis of I-profile cantilever beam

• Step definition for transient dynamic step

Create step

Based on the frequency of 

the eigenmode, set the 

duration of the step to 

approximately 5 vibration 

cycles

Set the maximum time increment to 

approx. 1/10 of the period of the 

eigenmode. This ensures that enough 

time points are used and the time 

history output is accurate.

Increase the maximum number of 

time increments to ensure that 

analysis does not end 

prematurely 

http://www.rand.fi/
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Where to find more information?

• Abaqus Example Problems, Verification, and Benchmarks in documentation

– Input files and other input data for all examples are available

– Example:

Open and copy/paste to text file or use Abaqus fetch utility:

abaqus fetch job=boltpipeflange_axi_solidgask.inp

https://help.3ds.com/2020/English/DSSIMULIA_Established/SIMACAEEXARefMap/simaexa-c-
boltpipeflange.htm?contextscope=all&id=f88c0b11fa174c71b902ec0a53859db4

http://www.rand.fi/
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Where to find more information?

Dassault e-seminars

Technical presentations, New features, Applications

https://events.3ds.com/  E-Seminars

http://www.rand.fi/
https://events.3ds.com/
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Thank you!
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